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FED17 - New Software for Magazine Springs

Helical compression springs with rectangular or oval or elliptic coil shape can be calculated by
means of new FED17 software. These formulas are applied for calculation of magazine springs:
phi = Mt*L/(G*It) = F*r*U*n/(G*It)=s/r
R=F/s=G*It/(r²*U*n)
It=pi/32*d^4 for round wire
U = pi*Dm for round coil shape
U = 2 Dma + 2 Dmb for rectangular coil shape
U = 2 Dma + (pi-2)Dmb for oval coil shape
R = Dm/2 for round coil shape
R =f(phi) for other coil shape

tau = Mt/Wt
Mt = F*r
taumax = F*rmax/Wt
Wt=pi/16*d³ for round wire



FED17 is almost equal with FED1+. FED17 has an additional input window for the coil shape, but
no database for catalogue springs and no cost calculation. You can select between 3 coil shapes:
- oval
- rectangular with bending radius
- elliptic

Length of coil shape is designated as "Da" and width of coil shape as "Db". If you set Da/Db=1 and
coil shape oval or elliptic, you can use FED17 to calculate cylindrical compression springs with coil
diameter D=Da=Db.
Same as in FED1+, FED17 provides Quick Input as well as separate input windows.



FED1+, FED5, FED6, FED7, FED17: 3D spring model as STL file
Compression springs can be generated as STL file now. Short compression springs could be printed
on a 3D printer. To show the spring as 3D model, you can install a STL viewer, if not already
available. To run the STL viewer automatically after generating STL file, configure "Exec CAD
App" at "File->Settings->CAD". Maybe you can use your CAD software to open the STL files.

FED5  Concentric End Coils
Concentric end coils can be used if block length should be as small as possible. But please consider
that concentric end coils cannot be led precise in a mandrel nor bore. FED5 now gives a warning if
you select mandrel or bore for production drawing of a conical spring with concentric end coils.

FED1+, FED2+: Cost calculation updated
At View->Printout->Cost you get an approximate cost calculation of the spring. This module was
programmed in 1994 and not modified since then. In 2004, base currency  DM was changed into
Euro with a factor of 0.511.
Currency database money.dbf was actualized now. Factor of the base currency EUR was changed
from 0.511 into 1, assumed that cost of a spring since 1994 has doubled, so that a spring of 1994 for
1 DM has a price of 1 EUR today. Cost of material, grinding, setting could be modified by the user
in Database menu.



FED1+: Quick Input Improved
Database access was reduced in Quick Input Window, material data will be actualized only if you
select another material. In earlier versions, material data was updated for each recalculation which
slowed down calculation speed and even could cause a crash if fast double click on "Calc" button.

FED1+, FED5, FED6, FED7: Setting length at Ls=Lc rounded
If you set setting length Ls=Lc , Ls will be rounded to next 1/10 mm.

FED1+, FED5, FED6, FED7: Setting length Ls printed
Setting length as entered at "Edit->Production Drawing" has been added to printout and Quick4
view , together with shear stress taus and load Fs at setting length.

FED3+ Tolerance of Coil Diameter
Tolerance of coil diameter to quality grade 1,2,3 is now calculated based on the center coil diameter
Dm, independent if De, Di or Dm was selected.



FED7 - 3D Centerline
3D centerline has been added in FED7 as drawing on screen, or to be exported as 3D DXF or IGES
file to be used with CAD.  Because FED7 calculates a compression spring of any form as series of
cylindrical spring sections, center line may be less or more disintegrated if coil diameter changes.

FED10  Quick4 View
New Quick4 view includes drawing, bedding draft with loads, tables with loads and calculation
results altogether on one screen in an ISO7200 drawing header.



FED5, FED6: Natural frequency of spring-mass system with external mass
Same as in FED1+, you can input an external mass at FED5 and FED6 now to calculate natural
frequency of the spring-mass-system. If spring length L2 is in the nonlinear zone of the load curve,
the spring-mass system has no constant resonance frequency, because spring rate changes with
spring deflection. This is an advantage of nonlinear springs. FED5 and FED6 calculate then the
natural frequency of the spring-mass-system at L1 and L2.
If you compare the natural frequency of the spring-mass-system with that of the naked spring, you
may be astonished that natural frequency of the spring-mass-system is much lower than that of the
naked spring even if external mass is nearly 0. The reason is that natural frequency of the naked
spring is calculated as natural frequency of the active coils with both spring ends fixed, and without
the mass of the end coils. For progressive springs, the difference is even higher, because number of
active coils becomes smaller with spring deflection, and mass of inactive coils is not considered.
For calculation of spring-mass-system, however, only one spring end is fixed and the other spring
end moves the external mass. Natural frequency is f=SQRT(R/m)/(2PI),  oscillating mass m
calculated as sum of external mass and 1/3 of spring mass.

FED5  Spring ends and block length if no end coils defined
If no end coils defined (n end=0), form of the spring ends (raw or ground) was not considered until
now and the block length was calculated until wire center (similar as for ground spring ends). Form
of the spring ends (raw, ground) is now considered, raw active coils increase block length. Except if
the coils bog-down until coil diameter.



XFED1: Special FED1 Freeware License for Sale
Spring manufacturers asked for a freeware version of the spring software as giveaway for their
customers. So we decided to offer a special freeware version of FED1.
Menus of XFED1 Freeware are reduced, (File, Edit, View, Help) this eases the use for beginners.
Quick Input Window with pre-dimension, dimensioning and recalculation of cylindrical
compression springs, altogether in one window. Output options are Quick1, Quick3, load-
deflection-diagram, spring drawing and production drawing.
Freeware version is property of the buyer, HEXAGON does not offer nor distribute freeware
versions. The license holder is free to offer the freeware version for unlimited download, or
distribute to certain customers and suppliers only.
XFED1 Freeware is a special version of  FED1. XFED1 runs without key code and may be copied
and distributed by the license holder without any limit. The license holder determines, if and how
his name and advertisement is included in software and printout.
The freeware can also be used internal. If no floating license of FED1+ is available from network,
you can calculate the spring with XFED1 and save. FED files of XFED1 and FED1+ are equal and
can be used with FED1+.
Freeware versions can never be downloaded on www.hexagon.de. We could set download links to
the download page of the license holder, if desired.
Acquisition of an unlimited freeware license XFED1 is exclusive and expensive: price is 13,500
EUR, as much as for 50 single licenses of FED1. If no one acquires a XFED1 freeware package,
there will be no XFED1 freeware.

WL1+ STL-Export

WL1+ can generate a STL file of the shaft now. If it is a rather short shaft, you could print a model
on 3D printer.

http://www.hexagon.de


WL1+: Quick4 View
New Quick4 View shows shaft drawing, draft with bearings and loads, tables with loads and
calculation results, altogether on one screen in ISO 7200 drawing frame.

WL1+: International Material Names in DIN 743 Material Database
Material numbers and material names to ISO, JIS, US and Chinese standards have been added to
DIN 743 material database. If you use materials from WST1 database in WL1+, you can search for
international material names in the WST1 material comparison database.



WN2, WN2+: Reversed sign at Ae caused error at e2min, e2max

Ring gears and internal splines were calculated with negative signs for number of teeth and
diameters so that all formulas were valid for both, external and internal gears and splines.
Unfortunately, nowadays American calculation method with major diameters and minor diameters
instead of tooth tip diameter and tooth root diameters with always positive sign are used for involute
splines. Together with the diameters, sign of tolerances have to be reversed for internal splines.
WN2 uses internal the "old German method". Only tolerances emin and evmin, emax and Teff and
Tact were calculated to new formulas. Unfortunately, there was forgotten to reverse the sign of
tolerance "Ae". If tolerance zone of internal spline is "H", Ae is 0. But if another tolerance zone
"F,G,J.K,M" was selected as tolerance zone, calculated tooth gap width emin, evmin and evmax of
the internal spline was calculated wrong. The error concerns gap width to DIN 5480:2006 only.
Span measurement, dimensions between pins and backlash were calculated correct always.



WN2, WN2+; WN4, WN5: Radial Backlash and Normal Backlash
Additional to torsional backlash, WN2+, WN4 and WN5 now also calculate normal backlash and
radial backlash. Normal backlash requires a customer for grinding allowance, and radial backlash to
compensate errors of a neighboured toothing.

       ----------------------------------------------------------------------
       torsional backlash min            jtmin    mm            0,024
       ----------------------------------------------------------------------
       torsional backlash max.eff        jtmaxeff mm            0,084
       ----------------------------------------------------------------------
       torsional backlash max.act.       jtmaxact mm            0,184
       ----------------------------------------------------------------------
       normal backlash min.              jnmin    mm            0,021
       ----------------------------------------------------------------------
       normal backlash max.eff.          jnmaxeff mm            0,073
       ----------------------------------------------------------------------
       normal backlash max.act.          jnmaxact mm            0,159
       ----------------------------------------------------------------------
       radial backlash min.              jrmin    mm            0,021
       ----------------------------------------------------------------------
       radial backlash max.eff.          jrmaxeff mm            0,073
       ----------------------------------------------------------------------
       radial backlash max.act.          jrmaxact mm            0,159
       ----------------------------------------------------------------------
       torsional backlash min            jtmin    °             0,05
       ----------------------------------------------------------------------
       torsional backlash max.eff.       jtmaxeff °             0,19
       ----------------------------------------------------------------------
       torsional backlash max.act.       jtmaxact °             0,41
       ----------------------------------------------------------------------

WN2, WN2+: Allowable Deviations to DIN 5480
Until now WN2+ printed allowable deviations according to DIN 3961 for involute gears and
splines. This was replaced now by deviations fp, Fp, Falpha, Fß and Fr according to DIN
5480:2006.

       ALLOWABLE DEVIATIONS ACC. TO DIN 5480:2006
       ----------------------------------------------------------------------
       Accuracy grade                                        9          9
       ----------------------------------------------------------------------
       profile tolerance, total          Falpha   µm        25         25
       ----------------------------------------------------------------------
       helix tolerance, total.           Fbeta    µm        16         16
       ----------------------------------------------------------------------
       single pitch tolerance            fp       µm        21         21
       ----------------------------------------------------------------------
       cumulative pitch tol.tot.         Fp       µm        50         50
       ----------------------------------------------------------------------
       runout tolerance                  Fr       µm        50         20
       ----------------------------------------------------------------------



ZAR1+, ZAR1W, ZAR5: Configure Resolution of Involute and Tooth Root Curve
If you use undercut gears, drawing may show a gap or edge at the transition of the involute into
tooth root trochoide if resolution is unsufficient. In this case, goto CAD->Settings and increase
"fillet resolution" and "number of points for involute polycurve" to about 100.

Tip: Configure Text Font
To give your printout an individual touch, you can configure another text font at File->Settings-
>Graphic". Click button Font and select font as desired. Default is Arial . If you scan or fax
your printout, set attribute "bold".

Another text font for the standard text printout can be configured at File->Settings->Printout with
Font button. Only fonts with constant text width can be configured there. Default is "Courier

New", text height 10. Set attribute "bold", then "Save" button.
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PRODUCT EUR
DI1 Version 1.2  O-Ring Seal Software 190,-
DXF-Manager Version 9.0 383,-
DXFPLOT V 3.2 123,-
FED1+ V29.6 Helical Compression Springs incl. spring database, animation, relax., 3D,.. 695,-
FED2+ V20.2 Helical Extension Springs incl. spring database, animation, relaxation, ... 675,-
FED3+ V19.0 Helical Torsion Springs incl. prod.drawing, animation, 3D, rectang.wire, ... 480,-
FED4 Version 7.3 Disk Springs 430,-
FED5 Version 15.6 Conical Compression Springs 741,-
FED6 Version 16.2 Nonlinear Cylindrical Compression Springs 634,-
FED7 Version 13.1 Nonlinear Compression Springs 660,-
FED8 Version 6.9 Torsion Bar 317,-
FED9 Version 6.0 Spiral Spring 394,-
FED10 Version 3.5  Leaf Spring (complex) 500,-
FED11 Version 3.3  Spring Lock and Bushing 210,-
FED12 Version 2.4  Elastomere Compression Spring 220,-
FED13 Version 3.9  Wave Spring Washers 185,-
FED14 Version 1.4  Helical Wave Spring 395,-
FED15 Version 1.3  Leaf Spring (simple) 180,-
FED16 Version 1.0  Constant Force Spring 225,-
FED17 Version 1.0  Magazine Spring 725,-
GEO1+ V6.1 Cross Section Calculation incl. profile database 294.-
GEO2 V2.6 Rotation Bodies 194,-
GEO3 V3.3 Hertzian Pressure 205,-
GEO4 V4.2 Cam Software 265,-
GR1 V1.0 Gear construction kit software 185,-
HPGL-Manager Version 9.0 383,-
LG1 V6.4 Roll-Contact Bearings 296,-
LG2 V2.2 Hydrodynamic Plain Journal Bearings 460,-
SR1 V22.2 Bolted Joint Design 640,-
SR1+ V22.2 Bolted Joint Design incl. Flange calculation 750,-
TOL1 V11.8 Tolerance Analysis 506,-
TOL1CON V1.5 Conversion Program for TOL1 281,-
TOL2 Version 3.3 Tolerance Analysis 495,-
TOLPASS V4.1 Library for ISO tolerances 107,-
TR1 V4.0 Girder Calculation 757,-
WL1+ V20.0 Shaft Calculation incl. Roll-contact Bearings 945,-
WN1 Version 11.6 Cylindrical and Conical Press Fits 485,-
WN2 V 9.9 Involute Splines to DIN 5480 250,-
WN2+ V 9.9 Involute Splines to DIN 5480 and non-standard involute splines 380,-
WN3 V 5.4 Parallel Key Joints to DIN 6885, ANSI B17.1, DIN 6892 245,-
WN4 V 4.6 Involute Splines to ANSI B 92.1 276,-
WN5 V 4.6 Involute Splines to ISO 4156 and ANSI B 92.2 M 255,-
WN6 V 3.0 Polygon Profiles P3G to DIN 32711 180,-
WN7 V 3.0 Polygon Profiles P4C to DIN 32712 175,-
WN8 V 2.2 Serration to DIN 5481 195,-
WN9 V 2.2 Spline Shafts to DIN ISO 14 170,-
WN10 V 4.0 Involute Splines to DIN 5482 260,-
WN11 V 1.3 Woodruff Key Joints 240,-
WNXE V 2.0 Involute Splines - dimensions, graphic, measure 375,-
WNXK V 2.0 Serration Splines - dimensions, graphic, measure 230,-
WST1 V 10.0 Material Database 235,-
ZAR1+ V 25.4 Spur and Helical Gears 1115,-
ZAR2 V7.7 Spiral Bevel Gears to Klingelnberg 792,-
ZAR3+ V8.9 Cylindrical Worm Gears 620,-
ZAR4 V5.1 Non-circular Spur Gears 1610,-
ZAR5 V11.1 Planetary Gearings 1355,-
ZAR6 V3.7 Straight/Helical/Spiral Bevel Gears 585,-
ZAR7 V1.0 Plus Planetary Gears 1380,-
ZAR8 V1.0 Ravigneaux Planetary Gears 1950,-



ZARXP V2.1 Involute Profiles - dimensions, graphic, measure 275,-
ZAR1W V1.7 Gear Wheel Dimensions, tolerances, measure 450,-
ZM1.V2.4 Chain Gear Design 326,-

PACKAGES EUR
HEXAGON Mechanical Engineering Package (TOL1, ZAR1+, ZAR2, ZAR3+, ZAR5, ZAR6, WL1+, WN1,
WN2+, WN3, WST1, SR1+, FED1+, FED2+, FED3+, FED4, ZARXP, TOLPASS, LG1, DXFPLOT, GEO1+,
TOL2, GEO2, GEO3, ZM1, WN6, WN7, LG2, FED12, FED13, WN8, WN9, WN11, DI1, FED15, WNXE,
GR1)

8,500.-

HEXAGON Mechanical Engineering Base Package (ZAR1+, ZAR3+, ZAR5, ZAR6, WL1+, WN1, WST1,
SR1+, FED1,+, FED2+, FED3+) 4.900,-

HEXAGON Spur Gear Package (ZAR1+ and ZAR5) 1,585.-
HEXAGON Planetary Gear Package (ZAR1+, ZAR5, ZAR7, ZAR8, GR1) 3,600.-

  HEXAGON Involute Spline Package (WN2+, WN4, WN5, WN10, WNXE)     1,200.-
HEXAGON Graphic Package (DXF-Manager, HPGL-Manager, DXFPLOT) 741.-
HEXAGON Helical Spring Package (FED1+, FED2+, FED3+, FED5, FED6, FED7) 2,550.-

HEXAGON Tolerance Package (TOL1, TOL1CON, TOL2, TOLPASS) 945.-
HEXAGON Complete Package (All Programs of Engineering Package, Graphics Package, Tolerance

Package, Helical Spring Package, Planetary Gear Package, TR1, FED8, FED9, FED10, ZAR4,
GEO4, WN4, WN5, FED11,WN10, ZAR1W, FED14, WNXK, FED16, FED17)

12,900.-

Quantity Discount for Individual Licenses
Licenses 2 3 4 5 6 7 8 9 >9
Discount % 25% 27.5% 30% 32.5% 35% 37.5% 40% 42.5% 45%

Network Floating License
Licenses 1 2 3 4 5 6 7..8 9..11 >11
Discount/Add.cost -50% -20% 0% 10% 15% 20% 25% 30% 35%
(Negative Discount means additional cost)

Language Version:
- German and English : all Programs
- French: FED1+, FED2+, FED3+, FED4, FED5, FED6, FED7, FED9, FED10, FED13, FED14, FED15, TOL1, TOL2.
- Italiano: FED1+, FED2+, FED3+, FED4, FED5, FED6, FED7, FED9, FED14.
- Swedish: FED1+, FED2+, FED3+, FED5, FED6, FED7.
- Portugues: FED1+
- Spanish: FED1+, FED2+, FED3+

Updates:
Update prices EUR
Software Update (software + pdf manual) 40,-
Software Update (software 64-bit Win + pdf manual) 50,-

Update Mechanical Engineering Package: 800 EUR, Update Complete Package: 1000 EUR
Maintenance contract for free updates: annual fee: 150 EUR + 40 EUR per program

Hexagon Software Network Licenses
Floating License in the time-sharing manner by integrated license manager
Individual licenses may not be installed in a network!

Conditions for delivery and payment
General packaging and postage costs are EUR 60, (EUR 25 inside Europe)
Delivery by Email (zip file, manual as pdf files): EUR 0.
Conditions of payment: bank transfer in advance with 2% discount, or by credit card (Master, Visa) net.

Key Code
After installation, software has to be released by key code. Key codes will be sent after receipt of payment.

HEXAGON Industriesoftware GmbH
Stiegelstrasse 8      D-73230 Kirchheim          Tel.+49 702159578     Fax +49 7021 59986
Kieler Strasse 1A      D-10115 Berlin                   Mühlstr. 13      D-73272 Neidlingen
Mobile: +49 163 7342509       E-Mail:  info@hexagon.de           Web: http://www.hexagon.de

http://www.hexagon.de

